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Technical Specifications
Geomatica® 9 Prime
Includes Fundamentals, PCI Visual ModelerTM, EASI +, Algorithms, and Fly!TM
GEOMATICA SOFTWARE SOLUTIONS
Geomatica Prime is the powerful, low-cost solution with tools for 
image correction, data visualization and analysis, and cartographic map 
production. Geomatica Prime includes:

• Focus, PCI Geomatics’ visual environment for working with a variety 
of data, including imagery, vectors, and graphical bitmaps.This is an 
application for viewing, enhancing, and examining remotely sensed 
imagery such as LANDSAT, SPOT, RADARSAT, ERS-1, NOAA AVHRR, 
IKONOS, QuickBird and aerial photography.

Geomatica Focus - PCI Geomatics visual environment

• Users can overlay their GIS data and view the attribute information 
associated with such data.

 
• Focus includes many useful display tools, such as fast roam and 

zoom, image enhancements, numeric value display, named regions, 
multi-histogram display, scatter plot, profile windows, attribute table 
display and information reports. 

• World-class OrthoEngine technology for performing image                  
geocorrection and mosaicking.

• OrthoEngine provides an easy to use GUI interface for project set-up, 
GCP collection, and correction by warping transformation for         
airphotos and satellite data, DEM building and mosaicking of       
imagery

• Geomatica provides the production management capabilities needed 
to initiate, monitor, and complete projects with ease, including    
workflow, imagery and vector data management, and error reporting.

• Underlying both the visual environment and OrthoEngine is PCI  
Geomatics’ GDB (Generic Database) technology, which gives users 
the ability to directly read/write 100+ imagery, vector, and other data 
formats.
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GEOMATICA PRIME                                   
SOFTWARE OVERVIEW
When Geomatica is installed, an icon for the Geomatica toolbar is 
placed on the desktop. When licensed for Geomatica Prime, the      
following toolbar will be opened.

Geomatica Toolbar

The icons presented in the toolbar are:

Focus

PCI Modeler

EASI

OrthoEngine

FLY!

License Manager

FOCUS - VIEWING ENVIRONMENT
The Focus viewing environment is divided into six sections as shown:

Focus: A - Menu Bar, B - Icon Toolbars, C - Maps/Files Treelist,
D - View Area, E - Overview Window, F -  Status/Message Bar

A - MENU BAR

Menu Bar

FILE menu 
• New Project - starts a new project and clears the viewer interface
• Open - access existing data files or a project file (.gpr) 
• Save Project or Save Project As - saves projects to specific   

destinations or overwrites existing project files

• Utility -> 
Import to PCIDSK
Link
Translate
Transfer layers
Import ASCII table/points
Export XML project

• Print Map - for full cartographic map production
• Print Map to File - to print the current map composition to       

Postscript, TIFF, JPEG, or HTML format file   

EDIT Menu
The EDIT menu includes items that allow the user to:
• Undo/Redo edits
• Cut, Copy and Paste layers in the tree list
• Group/Ungroup - vector elements such as polygons, shapes, text, 

and symbols
• Attach/Detach - items in the same layer using the Attribute      

Manager or Arrow Selector
• Set RepCode - special map editing tools for complex map         

production

VIEW Menu
• Area View Mode - shows the data in the full extents of the view 

area, in this mode no cartographic elements are shown, just the 
geospatial data that has been loaded

• Map View Mode - shows the data as it will be printed on piece of 
paper and cartographic elements are shown

• Zoom Window - this option creates a secondary viewer window 
that can be used to create different views of the same data sets

• Clone View - this option creates a secondary viewer window that 
can be used to reorder the layers and create different views

• Zoom To ->
Overview of Area
Zoom In
Zoom Out
1:1 Image Resolution
Zoom Percent

• Named Regions - tools for creating and utilizing custom zoom  
levels based on specific locations

• Visualization Tools
• Flicker
• Swipe
• Blend
• Loop
• Cycle 

• Toolbars - select toolbars to be displayed
• Show Grid - draws grid lines
• Snap to Grid - snaps text to grid lines
• Layout Grid Set-up - define grid properties
• Display Options - controls the Focus viewing environment
• Properties - view properties for the current highlighted layer in the 

tree list

LAYER Menu 
• Add - allows users to add the following layers to the View Area:

• Vector
• RGB
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• Greyscale
• Pseudocolored
• Bitmap

• Visible - allows the user to turn a layer on/off
• Selectable - sets whether the user can select shapes from the  

current vector layer
• Attribute Manager - view the attributes of a selected vector layer
• Histograms and Numeric Values - open analysis panels for the 

selected image layer
• Scatter Plot - a data visualization tool, it allows the user to 

instantly see where the majority of the data values are                  
concentrated 

• Profile - view a graph profile of the image layer
• Filter - apply a low pass, high pass, or custom filter to the image 

layer
• Area Neighbors - determines the adjacent polygons of selected 

polygons of interest
• Aggregate Attributes - shows summary statistics for an attribute 

table
• RGB Mapper - change the RGB combination of a layer that is     

displayed within the viewer

ANALYSIS Menu
• Image Classification ->

Supervised 
Unsupervised
Classification Analysis including:

• Accuracy Assessment
• Aggregation
• Class Editing
• Class Labeling

• DEM Editing - carry out simple editing proceedures specifically 
designed for elevation data

• Buffer - create buffers for both vectors and polygons
• Dissolve - merge features with common attributes
• Overlay - carry out spatial, statistical, and suitability overlays

TOOLS Menu
• Algorithm Librarian - provides easy access to many robust     

algorithms for image/vector processing and analysis
• EASI Modeling - access to Geomatica’s command-line based 

interface and scripting environment
• Raster Calculator - can be used on any file with raster channels, 

supports multiple files and raster attributes
• Data Merge

• Select input data
• Setup output file
• Setup output layers

• Reprojection - reproject and export data to a new file
• Clipping/Subsetting - create a new subset database derived from 

selected layers and other information sampled from an existing 
source file

• Digitizing Tablet ->
Register
Start Digitizing
Stop Digitizing

• GPS Tool - update the cursor within an area from a GPS unit or 
utilize GPS data for a new vector layer

• Representation Editor - supports thematic mapping
• Options - Several options are available for users to customize how 

Focus handles certain features and utilizes system resources.

HELP Menu
The Help menu includes the new HTML on-line help system,        
automated check for updates option, and a set of links to the PCI         
Geomatics web site.

B - ICON TOOLBARS

Icon Toolbars

The toolbars provide easy access to the following functions:
• New project
• Open file
• Save
• Toggle treelist
• Link windows
• New map
• New area
• Launch the add layer wizard
• Cut
• Copy
• Paste
• Undo
• Redo
• Zoom to overview
• Named regions
• Zoom interactive
• Zoom in
• Zoom out
• Zoom to 1:1 image resolution
• Pan
• Cursor control panel
• Open the information report panel
• Open the attribute manager
• Numeric values reports
• Measurement tools
• Selection tools
• Vector editing
• New shapes
• New text
• Raster erase
• Raster editing
• Spatial query
• Set symbol color
• Set symbol style
• Set line color
• Set line style
• Set area color
• Set area style
• Set text color
• Set text style
• Image enhancement tools
• Contrasts
5/31
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• Brightness
• Map view
• Area view

C - MAPS/FILES TREE LIST
 
MAPS Tab
This tab contains the layers that are currently being displayed in the 
VIEW area. The basic layer types include:

• RGB image layer
• Grey scale image layer
• Pseudocolor image layer
• Vector layer
• Bitmap layer

Maps Tab

For each of these layer types, there is a context menu, available with 
a right-mouse click. The functions within this menu affect the selected 
layer only.

These options are different for different layer types. They include:

RGB/BW Image Layer
• Cut/Copy - for moving the layer in the tree list
• Save - for saving edited layer 
• Save as - for saving edited layer into a new file or as a new 

layer in an existing file
• Remove - to remove the layer from the view
• Rename - to rename the layer in the tree list
• Layer Manager - specify layer properties (i.e. Layer Visible)
• Overview of layer - fits the selected layer into the view area
• 1:1 image resolution - Zoom to 1:1 resolution based on the 

selected layer
• Enhance - a sub-menu of options to apply various automatic 

enhancements, including the Edit LUT option for creating  
custom enhancements

• Filter - opens the panel for filtering the chosen layer
• Attribute Manager - opens the attached attribute table            

(if present) (BW Layers only)

• Numeric values - opens the numeric values panel for the   
chosen layer

• Histograms - opens the histogram panel for the chosen layer
• Scatter plot - opens a scatterplot panel for the chosen layer
• 3-D data cube
• Profile - opens the image profile panel (a vector will be added, 

although by using the selection tools, the user can select an 
element from a previously-loaded layer)

• Image Classification - provides a sub-menu for starting either 
a supervised or unsupervised classification session

• Properties - shows the layer properties, including file        
information, enhancement applied, and resampling method

PCT Image Layer
• Includes all the same choices as the RGB/BW layers except 

for: enhance, scatter plot, and image classification
• Selectable (thematic layers)
• Select all shapes (thematic layers)
• Unselect all shapes
• Edit PCT - allows the user to define the colours for the values 

in the selected image
• Representation editor
• Legend items

Bitmap Layer
• Cut/Copy - for moving the layer in the tree list
• Save - for saving an edited layer 
• Export (Save as) - for saving an edited layer into a new file or 

as a new layer in an existing file
• Remove - to remove a selected layer from the project
• Rename - to rename the selected layer in the tree list
• Layer Manager - specify layer properties (i.e. Layer Visible)
• Overview - fits the selected layer into the view area
• 1:1 resolution - Zoom to 1:1 resolution based on the selected 

layer
• Color - this sub-menu allows the user to choose a predefined 

color or create a color for the layer
• Representation Editor - gives access to representation editor 

for thematic mapping. 
• Properties - shows the layer properties, including file        

information and color applied to the bitmap layer

Vector Layer
• Cut/Copy - moves the layer in the tree list
• Save - saves the edited layer
• Save as - saves the edited layer into a new file or as a new 

layer in an existing file
• Remove - removes the layer from the view
• Rename - renames the layer in the tree list
• Layer Manager - specify layer properties (i.e. Layer Visible)
• Selectable - sets whether the user can select shapes from the 

current layer
• Select all shapes - select all shapes from the current layer
• Unselect all shapes - unselect all selected shapes from the 

current layer
• Overview of layer - fits selected layer into the view area
• Color - sub-menu allows the user to choose a predefined 

color or create a color for the entire layer
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• Representation editor - gives access to representation editor 
for thematic mapping

• Legend items - turn legend items off and on
• Attribute Manager - opens the spreadsheet function, viewing 

the attribute table for the selected layer
• Properties - shows the layer properties, including file        

information and what type of representation is applied

A menu also appears when a right-click is done without any layer 
being selected. The options provided in this menu include:

• Paste
• Save Project/Save Project As - to save the current set-up as a 

Geomatica project file (.gpr)
• Open - opens any GDB supported file format into the current 

view
• New Project - clears the current view to start a new project
• New Map - allows the user to create another map view in the 

current project
• Layer Manager

LEGEND in MAPS Tab
This feature is set by default under Tools->Options->General Interface 
menu and selecting the “Legend in Maps Tab” checkbox.

Vector layer legend in MAPS Tab tree list showing counties within the state of California, USA 

The displayed layers are represented in a legend tree list. The legend 
itemizes the representation and is unique for the type of layer 
selected as follows:

Vector
• Shows the legend entries for all the representation that is being 

used for that layer. For an RST all of the repcodes that are present 
in this layer are listed.

RGB image layers
• Shows a color ramp for each band and shows the range of raw 

pixel values in that layer.
Greyscale 
• Shows a grey ramp along with the range of raw pixel values. 
• If the layer is represented using thematic display, then each class 

in the GTD file will be shown.

Pseudocolored
• One entry for each range in the PCT. If the layer has metadata 

specifying the legend items, then only those will be shown.
• If the layer is represented using thematic display, then each class 

in the GTD file will be shown.
Bitmap
• One entry showing the color of the bitmap and optionally a  

description of the bitmap.
• If the bitmap is represented using thematic display, then there will 

be two legend entries.

These layers can be turned on and off by selecting the Legend Items 
option from the context menu, available from a right-mouse click in 
the Maps tab.

FILES Tab
This tab contains the information about all of the files that have been 
loaded into a project. Each file is listed, along with all of the layers 
within those files.
 

 Files Tab

A right click without selecting a layer in the tree list will open a menu. 
Which allows users to Add a file to the current project, launch the 
Data Merge wizard or access the Utility functions, such as Import, 
Link, Export, Reproject, and Clipping/Subsetting.

In the FILES tab, there is a right-click context menu associated with 
every item.

Files
For files, this menu includes:
• Save - to save the entire file with any edits that have been done
• Translate - options for translating the file into any other GDB     

supported file format
• New - sub-menu allows the user to add different layer types to the 

selected file
• Remove - allows the current user to remove the file from the      

current project
• Delete - removes the file from the project and deletes the file on 

disk
7/31



G
eo

m
at

ic
a®

 9
 P

ri
m

e
Te

ch
n

ic
al

 S
p

ec
if

ic
at

io
n

s

• Build overviews - allows the user to build overview layers for faster 
rendering of data in the application (note that this option from the 
File menu will build pyramids for all layers in the file)

• Delete overviews - allows the users to delete any pyramids that 
may exist in the file

• Algorithm librarian
• Properties - opens the properties panel for files, which contains a 

number of tabs, including:
• General Tab - contains information about the path to the file, 

the type of file and the size of the file
• History Tab - contains a listing of the operations that have 

been done to this file
• Metadata Tab - contains any metadata available for this file
• Projection Tab - lists the projection information for the file, 

including the projection, datum, and corner coordinates

For each layer type, there is also a right-click context menu. Each of 
the layer types is described below.

Image Layers
• Save - to save the layer with any edits that have been completed 

during the session
• Delete - removes the layer from the file
• View - automatically loads the layer to the view area and places 

the layer in the current area in the MAPS tree list.
• Attribute manager - opens the Attribute Manager if this layer has 

attributes associated.
• Export (Save as) - for saving edited layer into a new file or as a 

new layer in an existing file.
• Histogram stats - opens the histogram panel for the chosen layer.
• Build overviews - allows users to build overviews for the chosen 

layer. (Overviews are used for faster rendering of data in the   
application.)

• Delete overviews - allows the users to delete any pyramids that 
may exist for the chosen layer

• Properties - contains three different tabs of information:
• General Tab - lists general information about the selected 

channel, including description, data type, and disk size
• History Tab - shows the processes that have been run on this 

particular image channel 
• MetaData Tab - Lists any meta data that has been created for 

this image, such as a default LUT segment to be applied or a 
default background value, etc.

Vector Layers
• Save - to save the layer with any edits that have been completed 

during the session
• Delete - removes the layer from the file
• View - automatically loads the layer to the view area, and places 

the layer in the current area in the MAPS tree list
• Attribute Manager - Opens the spreadsheet function, viewing the 

attribute table for the selected layer
• Export (Save As) - for saving edited layer into a new file or as a 

new layer in an existing file. 
• Properties - contains four different tabs of information:

• General Tab - lists information about the vector layer,     
including short name, description, entity, count, and vector 
layer type

• History Tab - shows the processes that have been run on this 
particular layer

• Metadata Tab - lists any metadata that has been created for 
this layer

• Projection Tab - lists the projection information for this        
particular layer

• Edit combined layers

Other layers 
(i.e. Look-up tables, Bitmps, Psuedo-color tables, GCPs, Signatures, Text)
• Save - to save the layer with any edits that have been completed 

during the session
• Delete - removes the layer from the file
• View - will either load the data to the current view (bitmaps), or 

open the data in a text viewer (GCPs, text). May not be available 
for all layer types.

• Export (Save As) - for saving edited layer into a new file or as a 
new layer in an existing file

• Properties - contains 3 different tabs of information:
• General Tab - lists information about the name and      

description of the layer
• History Tab - shows the processes that have been run on this 

particular layer
• Metadata Tab - Lists any metadata that has been created for 

this layer

D - VIEW AREA

The View area contains the actual data that has been loaded.Within 
this area, a user can use the system cursor (typically a cross-hair) to 
place the cross-hair cursor where they want within the data they have 
loaded. The resulting position, image value(s), or vector ID will be   
displayed in the message bar at the bottom of the window. The          
information that is displayed also depends on what layer is currently 
selected in the MAPS tree list. If an image layer is selected and the 
selection tool is enabled, the vector layer name, entity ID, and length 
will be displayed.

For some of the functions in the toolbar, the cursor location in the view 
area controls what image should be affected. If a user has two images 
loaded to the window, the top image over which the cursor is         
positioned, is the one that will be affected should the user select an 
enhancement. In addition, if the user decides to zoom in to 1:1        
resolution, they will do so based upon the image visible where the  
cursor is located.

View Modes
In the Focus viewing environment, there are two view modes, Area 
mode and Map mode.

Area view mode shows the data in the full extents of the view area. In 
this mode, no cartographic elements are shown, just the geospatial 
data that has been loaded.

 Area View Icon
8/31
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Map view mode shows the data, as it will be printed out on a piece of 
paper. The size of the paper is controlled by selecting the map layer in 
the tree list and choosing the properties option. In this panel, there is 
a tab for paper size.

 Map View Icon

Added cartographic surround elements (scale bars, legends, and 
north arrows) will now show up in the view.

At any time, the user can switch back to Area mode, where they are 
now viewing data for a particular area rather than an entire map   
composition. The cartographic elements will not be displayed in this 
mode, but they are still active in the project.

The different view modes make it simple to do analysis work and    
create cartographic output, all in the same interface.

A menu also appears when a right-click is made in the view area. The 
options provided in this menu include:

• Clone view - creates a secondary viewer window
• View map - allows users to view a selected map from the Maps 

tree list
• Zoom to - which allows selection of the following:

• Zoom to Overview
• Zoom In
• Zoom Out
• 1:1 Image Resolution
• Zoom Percent
• Named Region

• New Shapes - which allows selection of the following:
• Points
• Line
• Polygon
• Rectangle
• Ellipse
• Trace
• Raster seeding

• Cut/Copy/Paste
• Vector Editing
• Set RepCode

Secondary View Windows
In the Geomatica viewing environment, there are two different types 
of secondary windows available. 

View -> Zoom Window - this option creates a secondary viewer      
window that can be used to create different views of the same data 
sets. For example, if someone wishes to zoom in within one window 
and leave the second at overview zoom level, they can do so with this 
function. 

Zoom View Window

Once the second window is open, the user can lock the window’s 
position by selecting the Lock Window Position icon in the tool bar. 

Lock Window Position Icon

View -> Clone View - This option creates a secondary viewer window, 
which can be used to create a completely different layer view from the 
main window.

Clone View Window

When the clone window is opened, a copy of the entire map from the 
main window is created in a separate window excluding the tree list. 
The user can then reorder the layers in the original view, and thus 
look at different data sets in the two windows.
9/31
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Once the Clone View Window is open, the user can link the cursor in 
the two windows by selecting the Link Windows icon in the tool bar. 

Link Windows Icon

E - OVERVIEW WINDOW
An Overview Window has been added to the Focus viewing          
environment for version 9.0. The Overview Window is located to the 
left of the View Area under the Maps/Files tree list.

When the user opens image data in Focus, the Overview Window 
shows a smaller version of the image in the Focus View Area. The 
Overview window has a bounding outline that the user can use to  
control the view in the View Area. Users can resize the bounding     
outline and zoom the View Area image. 

F - STATUS/MESSAGE BAR

Status/Message Bar

The Status Bar
The message bar at the bottom of the interface displays particular  
values based on the location of the cursor. These include:

• Location coordinates - can be any of the following units               
(if georeferencing is properly applied to the data)

• Paper (mm)
• Raster (pixels/lines)
• Geocoded (projection)
• Geographic (Lat/Long)
• MGRS (US military grid reference system)
• Screen (based on window size)

The user can select the units desired by selecting the second 
down arrow in the message bar.

• Image layer value(s) - If an image layer is selected in the Maps 
tree list, the gray level values of that layer will be displayed in the 
message bar for the cursor location. This includes the three values 
for an RGB layer or one value for a BW or Pseudocolor layer.

• Vector ID - If the user is in vector selection mode, and a single 
vector is selected, then the following information is displayed about 
that line: layer name, ID number and length of the line. If the user 
selects multiple entities, the number of selected lines is displayed.

• Zoom factor for the current layer

• Approximate scale factor that is calculated based on an 
assumed screen size

• Hint text for the icons in the toolbar. As the cursor passes over the 
icon, the hint text is displayed.

• Progress Monitor - Appears when longer running processes are 
ongoing. (left side of status area)

All of these options can be turned on or off using the first down arrow 
in the message bar. That way the user will only have the information 
they desire displayed.

VIEWING ENVIRONMENT - TOOLS

LOADING DATA
Geomatica Viewing Environment utilizes the GDB technology for 
directly reading raster, vector, and other information from an extensive 
list of supported file formats. This offers the advantage of quick and 
direct access to data, while eliminating the need to reproduce files 
since no conversion is necessary.
 
For a list of supported formats, please see the GDB Technology 
Technical Specification sheet.

Data of any bit depth, size, or resolution can be read into a single 
viewing window (as long as the projection information is correct).

Imagine being able to view all of your data in a single viewing        
environment without having to resample the data to a single            
resolution. All layers can be viewed at their own resolution at any 
time.

PROJECT FILES
Geomatica utilizes project files. Within the application, one can save a 
project and also open up an existing project.

Projects are a collection of links to data files with references to the 
way data from those files is currently being viewed. This includes the 
order in which Geomatica displays the layers, and any enhancements 
that have been applied to the imagery. 

A project is a way of saving information and being able to distribute it 
to others so they can see exactly what you are seeing (data files must 
be sent as well). They are also handy because you do not have to 
start from scratch again the next time you start Geomatica. You can 
begin where you left off.

DATA MANAGEMENT TOOLS

IMPORT/LINK
Under the FILE->UTILITY menu, there is an option for Import and also 
one for Link. These two tools allow users to import their data into 
PCIDSK format., and also the ability to create a file interleaved 
PCIDSK format file by linking to the existing files.

CLIPPING/SUBSETTING PANEL
Selecting the "Clipping/Subsetting" option from the TOOLS menu 
option allows the user to create a new subset database derived from 
selected layers and other information sampled from an existing 
source file. Users may select from a variety of output formats.

There are 4 areas to the subset panel:
10/31
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A: Input file selection area
Here the user can select the input file.

B: Available layers area
This is where the user selects the layers from the input file that they 
want subsetted to the output file.  Any number of layers can be done 
at once. 

One helpful capability of the subset panel is the ability to create a 
script that will subset a single file into a group of smaller files, the size 
of which is determined by the script.

C: Define clip region
This section allows the user to select the clip or subset area they want 
to use based on the extents of the input file.  They can do this visually 
by displaying a preview and then using their mouse to drag the box in 
the thumbnail window.  They can also enter the coordinates manually 
in the provided text boxes.  

Different methods can be defined for the selection of the clip or subset 
region, including:
• User defined co-ordinates
• Select a file
• Select a clip layer
• Select a named region

 Clipping/Subsetting Panel

Different reference systems can be used for the selection of the     
subset area, including:
• Database corners (pixel/line of upper left and lower right corner)
• Geocoded corners (projection coordinates of corners)
• Long/Lat corners (long/lat of corners points)
• Database offset/size (pixel/line of upper left with width and height 

in pixels/lines)
• Geocoded offset/size (projection coordinates of upper left and 

width/height)

An option to create tiles from the input file is also available.

D: Output file selection area
Here the user can select the output file name and the output file      
format. The Output file selection area also offers users to specify No 
Data Values or create an Output Clip Boundary Vector layer.  

REPROJECT PANEL
Selecting the "Reprojection" option from the TOOLS menu option 
allows the user to reproject an existing file, thus creating a new file 
with the same data in a different projection.

There are 3 areas to the reproject panel:

A: Source and destination file selection area
Here the input and output files are chosen, along with what format file 
the user wants to create.

B: Reprojection bounds area
In this section, the user must select the type of bounds to use:
• Pixels/lines and bounds varies the pixel size to create a file with 

the pixel, lines and bounds values that the user selects.
• Pixel/lines and resolution varies the bounds based on the           

resolution of the source file.
• Bounds and resolution allows the user to input file size in pixels 

and lines and to set the pixel size.

The user will then select the projection they wish to reproject to,      
setting up the projection parameters as prompted by the system.

Reprojection Panel

Then select the Resampling and Transform orders.  

Resampling options include:
• Nearest
• Bilinear
• Cubic
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C: Selectable Layers area
This is where the user selects the layers from the input file that they 
want in the output file.  Any number of layers can be done at once.

TRANSLATE (EXPORT) PANEL
The Translate (Export) panel can be accessed by choosing the FILE/
UTILITY -> TRANSLATE option.  This panel will allow users to    
translate a file from one format to another.  Neither the source or          
destination file has to be in PCIDSK format.

The Translate panel consists of three sections:

A: Source and destination file selection area
Here the input and output files are chosen.  The select buttons allow 
the user to browse their file system.

B: Format selection  
The user can choose from any of the GDB supported formats.  

For a list of supported formats, please see the GDB Technology  
Technical Specification sheet.

There is also an options box available in this section.  Some formats 
have different options associated with them.  By selecting the "?" icon, 
one can see the available options for the selected format.  For     
example, a TIFF file can be compressed using any one of  five         
different methods.
 

Translate (Export) Panel

C: Selectable layers area
This is where the user selects the layers from the input file that they 
want in the output file.  Any number of layers can be done at once.  
When a particular format is selected, only the layers that are        
applicable to that format will be available from the input list.  
For example, if one is translating from PCIDSK format to Shapefile 
format, only vector layers will be available for selection.

CONVERSION ALGORITHMS
The Algorithm Librarian includes 20+ algorithms for data conversion. 
These algorithms enable users to convert existing data layers into 
new data layers utilizing a variety of output formats (i.e. RAS2BIT - 
Converts a raster layer to a bitmap layer).

INFORMATION TOOLS

NUMERIC VALUES PANEL
The Numeric Values panel contains a text display of the digital values 
in one or more image layers, centered on the current cursor position. 
This panel can be accessed from the icon on the toolbar or from the 
LAYER pulldown menu.

Numeric Values Icon

The panel will display raw or enhanced data values.

 Numeric Values Panel
The numeric values panel can be opened for one image layer while 
the user investigates another layer. This is a very handy tool for    
completing image investigation.

CURSOR CONTROL PANEL
The Cursor Control panel available from the icon toolbar allows the 
user to view the different coordinates of the cursor location all at once. 
The coordinates shown include paper, raster, geocoded (based on the 
selected file), and user-defined (default is Latitude/Longitude).

Cursor Control Icon

This panel can also be used to place the cursor at a particular location 
using any of the displayed coordinate systems.
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Cursor Control Panel

For the user-defined section, one can choose any of the supported 
PCI projections.

For a list of supported projections, please see the                      
Georeferencing Technical Specifications sheet.

INFORMATION REPORT 
Display the individual attributes of selected vectors or the uppermost 
raster layer (whatever is under the cursor) with the Information 
Report. You can view and edit the attributes in the Information Report 
Panel. Changes to representational attributes are shown               
automatically in the view area. To open the Information Report panel 
select from the Icon Toolbar, the Information report icon.

 Information Report Icon

 Information Report Panel

ANALYSIS TOOLS

NAMED REGIONS
Create a custom view of your map or image with the Named Regions 
tool. When you create and open a Named Region, the Viewer roams 

and zooms the Named Region making it fit into the Focus viewer. To 
open the Named Regions dialog box:

• In the View menu, click Named Regions.
• You can also click the Named Regions icon on the Icon Toolbar.

Named Regions Icon

When adding a new Named Region, you must define the boundaries 
of your new region using either the zoom tools on the Focus toolbar, 
or by using the Advanced features of the Named Regions panel.

Named Regions Panel

MULTI-HISTOGRAM DISPLAY
The first panel shows an overview of the histogram for the number of 
images in the selected layer (3 for RGB, 1 for BW). By clicking on one 
of the histograms, a more detailed panel opens with the following:

• Horizontal dimension represents the gray level values from the 
minimum on the on the left to the maximum

• Vertical dimension is the frequency of each value in the selected 
layer

Multi Histogram Display Panel
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The panel displays the statistics including the mean, median,        
standard deviation, minimum value, maximum value, and the number 
of pixels for the entire selected layer.
Allows the user to select the minimum and maximum gray levels, and 
the minimum and maximum occurrence count on the histogram
The selected histogram can be printed in PostScript or ASCII, or 
exported out to a text file.

SCATTER PLOT
The Scatter Plot operation is primarily used as a data visualization 
tool. It allows the user to instantly see where the majority of data     
values (or pixels) are concentrated.

Scatter Plot Panel

The Scatter Plot operation takes two specified image channels and 
displays a scatter plot of the pixel distributions, with one channel used 
as the x-axis and the other as the y-axis.
The Statistics Area displays the linear equation for derived from a    
linear regression calculation and the correlation coefficient associated 
with the scatter plot.
The selected plot can be printed in PostScript or ASCII, or exported 
out to a graphic file format, such as BMP or TIFF.

PROFILE WINDOWS
The profile Viewer allows for viewing of the profile of the currently 
loaded images using the currently selected vector. It consists of two 
main panels: 

Profile Graph Panel

The profile graph panel that shows the input channels plotted with the 
gray values on the y-axis, and the distance along the vector on the    
x-axis.

The x-axis is measured in meters, and represents the distance 
between the end points of the vector. The range of the x-axis depends 
on the length of the vector and the scale of the area or the ground dis-
tance covered by the image.
There are two mensuration bars, which control the values in the   
mensuration area of the dialog box. These allow the user to measure 
between any points along the profile line.
The selected profile graph can be printed in PostScript or ASCII, or 
exported out to a graphic file format, such BMP or TIFF.

Profile Table Panel

The profile table panel lists numeric information for each sample point 
along the current profile. A sample point is a pixel. The spacing is 
determined by the pixel size. The range depends on the length of the 
vector and the image scale. The table contains the following         
information:

• Sample number depends on the length of the vector and the 
size of the pixels.

• The first set of channels or columns contains the gray level 
values of the currently selected layer(s).

• The position of the sample point in pixel/line coordinates.
• The georeferenced X position of the sample point.
• The georeferenced Y position of the sample point.
• The distance in meters relative to the first sample point.
• Note that the table of values can be exported to a text file.
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FILTER
The Filter dialog box is used to enhance or subdue the details of the 
active image in the MAPS tree. The dialog box is used to provide     
different filter operations on an image. A filter can be used to sharpen, 
smooth, or detect edges that are present in an image.

Filter Panel

Some of the filters supported include Average, Gaussian, Median, 
Mode, Gamma, Edge Detector, Laplacian, Sobel, and Prewitt. There 
is also an option for creating user defined custom filters.

The filters can be applied in two different ways:

• Apply to view - filters currently loaded data on the fly. The filter will 
be reapplied everytime the view is changed.

• Apply to file - this option will filter the entire layer on disk, creating a 
new filtered layer, which the user can output to the file of their 
choice.

VECTOR DATA TOOLS

ATTRIBUTE MANAGER
The Attribute Manger table allows for viewing the attribute data of the 
selected layer. To open this panel, select a vector layer in the MAPS 
tree list and then choose the Attribute Manager option in the LAYERS 
pull-down menu, or use the “open the Attribute Manager icon in the 
toolbar.

 Attribute Manager

This attribute table includes many functions typically found in   
spreadsheet tools.

Functions include:
• Find capability to search for particular values
• Ability to change view to single record or table style
• Choice of viewing all data or only the selected data
• Functionality for sorting based upon a particular attribute or         

multiple attributes, in either ascending or descending order
• Ability to select a particular record and have it highlighted in the 

view area, as well as having selections in the view area highlighted 
in the spreadsheet

• Capability to build complex queries based upon the attribute data 
(query by example)

• Print to file
• Adding and deleting records
• Adding and deleting fields
• Computing new fields based on existing fields
• Zoom to selected shapes after the selection is performed in the 

attribute manager
• Table join is available, which links attribute tables based on like 

attributes. In addition, the table is linked with the main view area. 
When vectors are selected in the view area, they are highlighted in 
the attribute table (if opened). Conversely, when a record is 
selected in the table, it is simultaneously highlighted in the view 
area.
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DISSOLVE
Merge features with common attributes that meet your specific 
requirements using the Dissolve command. To open this panel 
choose the Dissolve option in the Tools pull-down menu.

Based on the attribute or group, generate statistics using the following 
drop down function selections: First, Last, Sum, Mean, Min, Max, 
Mode, Median, Standard Deviation, Ignore, and Weighted Average.

You can use the Dissolve Attributes function on vector layers only. In 
some cases adjacency criteria are required. Vector layers do not have 
to be open in the current project.

Dissolve Attributes produces either a vector or thematic raster layer 
result. When the dissolving is completed, your output is added to the 
FILES tree list. You do not need to add new layers to the MAPS tree 
list.

Dissolve Panel

BUFFER
Add buffer polygons, around specified objects in your input data 
based on their location. To open this panel, choose the “Buffer” option 
in the Tools pull down menu.

Buffer Wizard Panels

Use the Focus Buffer Wizard to create buffer zones. Options include:

• Buffer Distances option, select Simple, Current Display or 
Attributes and specify the buffer levels and units to be used.

• Specify the type of buffer to display based on Vertex, Line or     
Polygon options

• Create Buffers for both vectors and polygons. 

• Vector layers do not have to be part of the current project. 

• When vector buffering is complete, the output is added to the 
FILES tree list.

OVERLAY 
The Overlay Wizard offers users three overlay options:

Spatial Overlay
• One output based on many vector and/or thematic raster 

inputs

Statistical Overlay
• Compute statistics by virtually overlaying two layers

Suitability Overlay
• Create one raster layer showing suitability of the many input 

raster layers

Overlay Wizard

AGGREGATE ATTRIBUTES
Show summary statistics for an attribute table with the Aggregate 
Attributes panel. To open this panel, choose the Aggregate Attributes 
option in the Tools pull down menu.

Aggregate Attributes Panel
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• Based on the pixel value or area, generate statistics using the     
following drop down Function selections: First, Last, Sum, Mean, 
Min, Max, Mode, Median, Standard Deviation, Ignore, and 
Weighted Average.

• The Aggregate Attributes function is similar to the Dissolve 
Attributes function. Although they perform the same operation, the 
Aggregate Attributes function produces a tabular result while the 
Dissolve Attributes produces either a vector or thematic raster 
layer result.

• Aggregate Attributes can be used only on layers with a currently 
opened attribute table. 

• Aggregate Attributes are displayed in a new spreadsheet window 
that exists in memory only.

SPATIAL QUERIES
For vector data, spatial queries can be accessed from the icon        
toolbar. 

Possible queries include:
• Fully Within
• Partially Within
• Within Distance
• Fully Within Distance
• Crosses
• Contains
• Query By Example (QBE)

DISPLAY STYLES
Within the Geomatica Focus, there are multiple ways to display     
vectors. These methods include:

Default Representation
There is a default representation automatically applied to each Vector 
layer when it is opened. This type of representation is simple and is 
used when no other representation style is applied to the layer.

For this type of representation, the default color is unique to each 
layer. In addition, this representation is project specific, that is, it is 
saved in the Geomatica Project file (*.gpr) and is not portable.

The Default Representation can be customized using the Style   
Selector. The Style Selector can be accessed by selecting Options 
from the Tools menu. From the options panel, select Default          
Representation from the treelist, then select Point, Line, or Polygon. 

Style Selector

Internal Representation Mechanism (IRM)
For IRM, the vector representation is stored internally in the PCIDSK 
file. This is a simple representation and is controlled by the            
Representation Editor.

The Representation Editor can be accessed by right-clicking the 
active layer and selecting Representation Editor from the context 
menu. Colors can also be changed by selecting Color and desired 
representations can be saved by selecting Save or Save As from the 
context menu. 

This type of representation is restricted to PCIDSK files only, and the 
representation cannot be separated from the PIX file or used with 
another project or file.

Representation Style Table (.rst)
This is the method used most often for complex map production. It is 
a complex representation that uses a multi-part RepCode. The RST 
representation is portable from any Map or Project to any Map or 
Project. It can also be linked to any GDB supported vector format, not 
just PCIDSK.

The Representation Editor panel can be opened by right-clicking on 
the active layer within the MAPS tree and selecting the                   
Representation Editor option.

Representation Editor Panel

An RST can be created or modified by right-clicking the RST from the 
treelist within the Representation Editor Panel.
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EDITING TOOLS

There are a series of tools that can be used for editing any layer that 
has been loaded into the Geomatica Viewer area. This includes 
image, vector, and bitmap layers. These tools can be accessed from 
the icon toolbar, as shown below. For image and bitmap layers, these 
tools are only available if the zoom level of the data in the view is 1:1 
or greater.

Editing Tools Toolbar

The tools in this section of the toolbar include:

• Selection tools, discussed earlier

• Vector editing tools, for opening auxiliary toolbar as shown

Vector Editing Tools Toolbar

This toolbar includes these vector editing tools:
• Find
• Reverse
• Add Vertices
• Join
• Split
• Extend
• Merge
• Mirror Tools
• Rotation Tools
• Start Node
• Previous Vertex
• Midpoint of Segment
• Next Vertex
• End Node
• Show Vertices
• Vertices

• Line drawing tools - Included in the pull down are tools for freehand 
tracing and adding points.

• Shape drawing tools - Includes tools for drawing squares,          
rectangles, circles, ovals, polygons, and also a tool for seeding a 
polygon.

• Text editing tool - Allows user to place text in a vector layer. With 
RST attached to a vector layer, a more complex text tool is 
enabled.

• Erase tool - for erasing edits in bitmap layers and classification 
sessions.

• Raster editing - setting fill, pixel values, line width

• Spatial query, discussed earlier

When editing layers, the display toolbar can control the color, line 
style, thickness, fill color, fill pattern, font color, font, and point symbol 
being used.

Display Tools Toolbar

When editing an image layer, please keep in mind that the color 
selected from the display toolbar is the “non-enhanced” value. This 
means that it may not show up exactly as selected in the tool when 
drawn in an enhanced image.

When editing a vector layer with an RST attached, there is a tool 
available from the menu system for controlling the RepCode being 
used. This is the Edit->Set RepCodes option.

DEM EDITING

2-D DEM editing is available from the Analysis menu. This option 
allows the user to carry out some simple editing procedures           
specifically designed for 8, 16, and 32-bit elevation data.

2D DEM Editing Panel

The panel enables the user to apply functions under a mask area, or 
to apply the functions to the entire layer.

Once a mask is created, the user is able to fill the area under that 
mask using the average value or a user-defined value.

Filtering and Interpolation functions available on the 2D-DEM Editing 
panel include:

• Remove noise
• Erode holes
• Interpolation
• Median filter
• Smooth DEM

Each of these functions runs on a disk level, meaning the result will be 
stored in another image layer. The user will be prompted to enter the 
layer when the a function is selected.
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IMAGE CLASSIFICATION

Image classification is a fundamental part of image analysis and   
Geomatica Focus provides users with interactive classification     
functionality. All of the class information and setup is stored as    
metadata for the layers being used in the classification process. This 
enables the user to carry out a classification over a number of          
different sessions without losing any of the previous work.

Within Geomatica Focus all of the layers being used in the             
classification process are grouped into a “meta-layer” in the tree list. 
This organizes all of the necessary layers into one place in the tree 
list. The “meta-layer” has a number of options available in a right-click 
context menu. These include:

• Remove - to remove the meta-layer from the view. (This also 
removes all the layers included underneath.)

• Rename - to rename the layer in the tree list

• Configuration - opens the session configuration panel, enabling 
the user to change the input, visible, training site, and output layers

• Edit PCT - allows the user to change the class colors using the 
standard PCT editing panel

• Open training sites - opens the training site editing panel

• Run classification - opens the panel for running the classification 
process using any of the supported algorithms

• Utilities - includes options for displaying the signature                
separabilities or classification preview

• Post-classification analysis - with options for starting any of the 
post-classification options, using the current configuration. (The 
“meta-layer” will change based on the type of action being     
undertaken.) The post-classification options include:

• Accuracy assessment
• Aggregation
• Class editing
• Class labeling

Image classification capability includes:

UNSUPERVISED CLASSIFICATION
• Isodata, K-Means (Minimum Distance) and Fuzzy K-Means 

unsupervised clustering (255 classes, 16 input channels).
• Specify a background value to be ignored during classification 

or the number of samples to collect on which to perform the 
iterative clustering.

• Use of bitmap possible to include or exclude areas for        
classification

K-Means Unsupervised Classification displayed in Focus

SUPERVISED CLASSIFICATION
• Parallelepiped and Parallelepiped with Maximum Likelihood 

Classification tie breaker (254 classes, 16 input channels).
• Maximum Likelihood Classification with optional null class.
• Minimum Distance Classification based on Euclidean          

distance (256 classes, 16 input channels).
• Use of bitmap to include or exclude areas for classification.
• Create signatures for a region under a mask using data from 

a set of image channels.
• Use of table for displaying class information, which makes all 

information fully editable.
• Training site editing, uses the same editing tools as discussed 

in the section above, including the polygon seeding function 
that helps to easily define training sites. 

Class and Training Site Editing
Use the training site editor to create and edit your classes so you can 
use them to supervise your classification. 

Training Site Editing Panel

The editing options include:

Value
• Specify class values

Name
• Provide a name for each class

Color
•  Select a color to represent each class
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Threshold 
• Set threshold values to reduce the chances of pixels being 

classified into more than one class

Bias
• Weigh one class in favor of another to resolve overlap 

between classes

Imported Signature 
• Import signatures to define training sites for classes.           

Signatures can be imported by right-clicking within the   
Imported Signature column.

Description
• Provide a description for each class

   
Opacity 

• Specify opacity to enhance display of training areas. 

The menubar offers three options:

1. Class
2. Edit
3. Tools

1. Class Menu
The Class menu includes:

New
• Create new classes

Import 
• Import bitmap, vector, or signature segments to use as      

training areas.

Merge 
• Merge classes 

2. Edit Menu
The Edt menu includes:

Clear Selected 
• Clear all training sites from any classes selected within the 

Training Sites Editing panel.

Clear All 
• Clear training sites from all classes within the Training sites 

Editing Panel 

Delete Selected 
• Delete selected classes from the Training Sites Editing panel.

Delete All 
• Delete all classes from the Training Sites Editing panel

3. Tools Menu
The Tools menu includes:

Signature Separability
• mean and standard deviation for each input channel under 

the class’s training area mask
• correlation and covariance matrices

Scatter plot
• Data visualization tool that allows the user to instantly see 

where the majority of data values (or pixels) are concentrated
• Takes two specified image channels and displays a           

scatterplot of the pixel distributions, with one channel used as 
the x-axis and the other as the y-axis

• User can view results for the entire layer, or just for a selected 
class

• Class ellipses and means plotted with controls on a per class 
basis 

Signature Statistics
• mean and standard deviation for each input channel under 

the class’s training area mask
• correlation and covariance matrices

Histograms
• Creates a Signature Histogram panel showing histograms for 

the currently selected training site for each classification Input 
channel.

• Shows if the training site data is normally distributed or not

Classification Preview
• Allows the user to generate a preview of the classification 

using any one of the supported algorithms:
• Maximum Likelihood
• Maximum Likelihood with Null Class
• Parallelepiped
• Parallelepiped with MLC Tie Breaker
• Minimum Distance
• There is also an option to Show Training Sites

• Preview can be generated at any resolution

POST CLASSIFICATION ANALYSIS
A number of post classification analysis options are available. In the 
MAPS tree, right-click the Classification MetaLayer. The options 
include:

• Accuracy Assessment
•  Aggregation
• Class Editing
• Class Labeling

Accuracy Assessment
• Generate area and percentage reports on classification results for 

the entire image, or a user specified sub area
• Confusion matrix reports
• Report of user’s and producers accuracies, overall accuracy, and 

kappa statistic

Class Editing
• Edit or modify class signatures prior to classification
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• Merge two class signatures to create a new class signature. Select 
the threshold, and the a priori probability for the new signature 
class

• Automatically merge signature pairs, which have the lowest      
separability among a set of signatures, until a minimum              
separability threshold value is reached

Class Aggregation
• Display upto 255 selected classes in different colors, group classes 

into aggregates
• Ability to edit the colors of classes, and change classes under 

graphic masks to another class
• Aggregation includes the ability to import class definition and the 

generation of pseudo-color tables is possible

Class Labeling
• Interactively view or modify the class information list associated 

with a particular channel
• Create, delete, import, and save classes in the class information 

list
• Allows editing of the value, name, color, and description of the 

class information list
• The class information list can be sorted in ascending order by 

value, name, color, or description
• Isolate which classes have a duplicate name or color by sorting
• Column headers for the Name and Color field containing         

duplicates will be displayed in red

MAP PRODUCTION

One of the most unique features of Geomatica Focus is the ability to 
create cartographic maps within the same environment that the 
geospatial analysis is carried out in. By simply switching from “Area” 
view to “Map” view, one can create and print a professional map.

Cartographic Map Production in Geomatica Focus

MAP PRODUCTION IN FOCUS
The properties of the map being produced are controlled by the    
properties of the map layer in the tree list. These properties include:

• Map Name
• Page Setup
• Default RST

Within a single map, there may be many different georeferenced 
areas. Each area can have a set of cartographic elements assigned to 
it. The surround elements can be created by right-clicking on the area 
in the tree list and selecting the “Surround” menu option. The           
following elements can be created:

• Neatline
• Border
• Grid - either georeferenced or paper coordinates
• Legend - for both imagery and vectors
• Logo - users can import their own logo quickly and easily
• North Arrow - 22 different styles are supplied
• Scalebar - 6 different styles supplied
• Title/Sub-title

Also available within Geomatica is the ability to index a legend. From 
the area right-click menu, the user can select the “indexation” option.

MAP PRINTING
The printing process can use Windows native printer drivers to send 
your map directly to a printer configured on your system. There are 
two selections of printing to choose from:

• Print Map - for full cartographic map production for:
• Native Windows printing - Supported
• Color Separation - Separates colors in a map into        

primary colors for professional commercial printing.
• Print Map to File - To print map composition to the following 

formats:
• Adobe Illustrator (AI, EPS)
• PCIDSK
• TIFF
• HP RTL
• BITMAP
• JPEG
• Web Publishing (HTML)

ON-LINE HELP SYSTEM

PCI Geomatics is proud to include a new on-line help system, which 
utilizes your HTML/Web Browser system. This help structure will be 
simpler to use, providing a more modern system that includes screen 
snaps and automatic links.

The help system is accessed from the Help pull-down menu and 
selecting the General option, which starts at the top level of help. In 
addition, help is available by choosing the Help button found in many 
panels, which will open the help for that specific panel. From there 
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you will be able to access the help information for any of the features 
in Geomatica. 

Also available from the HELP menu is:
• About Geomatica Focus
• Check For Updates
• PCI Geomatics On The Web, including:

• Free Stuff
• Product Information
• Online Support
• Best of the Web
• PCI Partners
• PCI Geomatics Home Page

General Help Panel

GEOMATICA ORTHOENGINE 

Geomatica OrthoEngine displayed with Geomatica Focus

ORTHOENGINE TECHNOLOGY
Geomatica OrthoEngine provides an easy to use GUI for project    
set-up, GCP collection, and geometric correction/registration, DEM 
building and mosaicking of imagery. It provides the production      
management tools needed to begin, monitor, and complete projects 
with ease, including workflow, imagery, and vector data management 
and error reporting.

OrthoEngine Toolbar

OrthoEngine technology is included within Geomatica Fundamentals 
and Geomatica Prime packages. This functionality is expanded by 
specialty sensor math models in the OrthoEngine Airphoto Models, 
Satellite Models, High-Resolution Models, and RPC-Generic Models 
packages, allowing orthorectification of air photos, digital camera 
frames, and optical and radar satellite imagery. Automatic DEM 
extraction is also available for selected stereo image pairs and 3D 
stereo viewing. Moreover, processing efficiency for large projects is 
improved significantly with Productivity Tools for chip database match-
ing, automatic tie point   collection, and automatic mosiacking. These 
features can be added to Geomatica, creating a package tailored to 
user requirements.

Project Setup
OrthoEngine’s simple GUI allows easy project set-up and workflow 
management.

• Create a project file that will contain all project data.
• Delete an image from the project.
• Rename/move an image within a project.
• Automatic project backup.
• Set orthorectified image output format to PCIDSK, TIFF or       

GeoTIFF, or use the File Utility to export to another format.
• Set GCP and output projections. The user can input GCPs in    

multiple projections, and use a DEM in another projection.
• View and edit the georeferencing system, bounds, and projection 

definition for the data layers.
• A variety of datum’s and ellipsoids are supported and extra ones 

can be added via a text file.
• Ctrl/Shift for multiple file import.

OrthoEngine Project Information Panel

GCP Collection
• Collect GCPs:

• Manually
• From Geocoded image files
• From Geocoded vector files
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• From a Chip Database file, including correlation
• Collect GCPs from digitizing tablet
• Import GCPs from text file

• Customize the colors of GCPs and tie points
• Given a georeferenced position, automatically estimate locations 

of new GCPs based in uncorrected imagery once a model has 
been established. 

• Set point as GCP or check point
• Delete GCP from list
• Use previously collected GCPs in overlapping images
• The geocoded X,Y and elevation values of the existing GCP will be 

extracted and filled in automatically
• Enter uncertainty values for GCP ground position or elevation to 

control weighting
• When manually collecting GCPs with only “x,y” coordinates, the 

user may extract a “z” value from a DEM file

Image Layout Panel
• View relative layout of all project images
• Review distribution of GCPs

Residual Report Panel
• View residual errors for each GCP
• Set residual error computation to micron, pixel, or ground units
• Computed x, y, and z values can be viewed for GCPs (in ground 

units)
• Report summary statistics for overall project accuracy
• Save report to text file for project records or delivery to client

Import and Build DEM Information (add-on)
• Raster Digital Elevation Models (DEMs) can be generated from the 

following sources:
• Raster files, such as DTED, USGS, DEM, or any supported raster 

format
• Contours, points and break lines from any supported vector format
• TIN models

• 2D DEM editing tool is supplied
• DEM can be used as input for GCP elevations or ortho 

generation

Use OrthoEngine to build DEMs from “contour” vector files

Image Correction
• Polynomial and Thin Plate Spline math models for geometric     

correction using GCPs
• Mosaic-Only option for assembling existing orthoimages or tiled 

image products without geometric changes
• Set up and schedule the production of geometrically corrected 

images
• Several images can be selected and then processed in batch 

mode
• Select output resolution
• Output bounds can be edited for the image being corrected
• Optionally delete uncorrected images to save disk space
• Adjust cache size to improve processing speed
• Resample using nearest neighbor, bilinear, cubic convolution, sin 

x/x algorithms or filter using average, median, Gaussian, or       
user-defined algorithms

Mosaicking
• Create a new output mosaic file or select an existing one from the 

disk. The user can define or view the current size and geographic 
extents of the mosaic file 

• View the positioning of files relative to the mosaic area
• Manually select cut lines, and perform blending and color           

balancing on a per image basis
• Preview the effects of mosaicking without actually performing the 

operation to disk. Preview windows are updated interactively when 
you make changes to cut lines or LUTs

• User can select background color when creating mosaic file
• Reapply saved cut lines and LUTs to regenerate mosaic
• Clipping/Subsetting of output mosaic into smaller files (tiles)

 Perform Blending and Color Balancing 

Image Display
• View uncorrected or raw image data along with the clip region, tie 

points, GCPs, elevation match points, in an image window
• Display graphical overview of the relative positioning of the project 

images, and GCPs using the layout panel
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• Enhance each image view with one of three enhancements:       
Linear, Equal, or Root

• Display full resolution subset, or select zoom factor
• Recenter the view on the current cursor location

Project Report
• The “Project Report” panel is used to provide a text report of the 

project information:
• Easily customizable to include any of the following:

• General information such as the filename and       
description

• Information about the output mosaic such as its           
resolution and georeferencing

• Information about the image such as the uncorrected 
and orthorectified filenames, the clip region, and the 
selected DEM file

• Computed geometric model information
• Ground control point information lists the GCPs collected 

on the image, with ground and image coordinates
• Save report to text file for project records or delivery to client

IMPORT/EXPORT OF DATA

GDB (GENERIC DATABASE) TECHNOLOGY
PCI Geomatics software uses GDB Technology to directly read and 
write raster, vector, and other information from an extensive list of 
supported file formats. This offers the advantage of quick and direct 
access to data, and eliminates the need to replicate files since       
conversion is no longer necessary.

GDB technology offers an extensive list of supported file formats

Supported Formats: See GDB (Generic Database)                     
Technology Technical Specification Sheet

PCI VISUAL MODELER

PCI Visual Modeler gives professionals, even those with a limited  
programming background, the ability to develop sophisticated         
process flows. The intuitive visual-scripting environment allows these 
processing flows to be constructed via a simple "point-and-click"   
interface.

Main Panel
• Provides an interactive methodology for the creation of          

sophisticated data processing flows.
• Process flows have an easy-to-interpret flow chart look.
• Process flows can be saved in a device- independent format.
• Executed process flows can be stopped and started easily.
• Inspection of intermediate results possible via pipe caches.
• Ability to do batch execution of several process flows.
• Stand alone module execution is supported.
• All GeoGateway data types are supported.
• Full data rendering support (raster, bitmaps, vectors, etc.).
• Integrated on-line help facility to display information related to the 

help option/topic selected.

PCI Visual Modeler Main Panel 

Module Librarian Window
• Over 275 processing modules categorized in an easy to navigate 

Module Librarian
• Example models (processing flows) are provided for each of the 

supported modules
• Module search capability
• Task description adjacent to each module 

Module Librarian Window

Processing Modules
• Modules have unique icon groupings for clear task identification.
• Icons located over the input and output ports of a module help 

identify its data processing needs.
• Parameters within each Module's processing panel have intelligent 

defaults.
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Module Control Panel

PCI Visual Modeler includes a broad spectrum of remote sensing and 
spatial analysis functions. These same functions can also be 
accessed via the Algorithm Librarian window in Focus. For a complete 
list of the tasks available, please see the Algorithm Librarian entry in 
this document. 

PCI Geomatics acknowledges the support of the RADARSAT user 
Development Program of the Canadian Space Agency for partial 
funding of PCI Visual Modeler. We also acknowledge the technical 
support of the Canada Centre for Remote Sensing.

EASI PROGRAMMING LANGUAGE

EASI is a full-featured interpreted programming language. The     
command-line based interface and scripting environment provide the 
user with powerful tools for customization and programming. 

EASI Command Window

• Support for scripting the Geomatica Viewer using Java, and COM 
supported languages such as MS Visual Basic. 

• Support for object-oriented programming
• Error handling produces a numeric error code and corresponding 

textual error message
• Support for all PCI Geomatics command mode functions, with 

complete syntax documentation
• Perform data modeling through direct access to strings,               

projections, vectors, rasters, binary files and text files
• Define local or global variables. Variables types include: 

• Integer - 4 byte signed integer number
• float - 4 byte single precision floating point number
• double - 8 byte double precision floating point number
• char - single character (1 byte)
• byte - single unsigned byte

• string - arbitrary long string of characters
• mstring - multi-line string
• mvar - modeling intermediate array
• arrays

• Declare local or global pointers with dynamic memory allocation
• Use conditional statements (if, else, elseif)
• Create expressions (Numeric, string, mstring and logical), logical 

expressions include:
• logical numeric expressions ( = , < , > , <= , >= , <> )
• logical string expressions ( = , <> , literal string, string        

variable, indexed element of an mstring variable, character or 
character array variable, character parameter)

• logical relations (and, or, not)
• ·looping (while)
• counted loop (for)
• branching (goto)
• returning (return)
• stopping (stop) 

• Build structures and functions.
• Modify command files in the Text Editor. Tools include: open, new, 

save, save as, execute, cut, copy, paste, clear.
• Specify your favorite editor as the default in the system settings
• The add-on Software Development Kit w/ GDB Technology can be 

used for user developed PACE programs using FORTRAN or C/
C++

FLY!

FLY is a powerful terrain visualization tool, which drapes imagery and 
vectors over DEM data to create 3-D perspective scenes in near   
real-time. An intuitive point-and-click user interface enables you to 
control flight speed, direction, elevation and perspective parameters 
interactively during flight. With FLY you can quickly and easily view 
imagery in 3-D from any position or perspective! FLY also allows for 
rendering in anaglyph 3-D mode and includes fogging effects.

Fly! 

3-D PERSPECTIVE SCENES                                         
AND REAL TIME FLY-THROUGHS
• Create a terrain using elevation data and color information from an 

image database file
• Full color - Three-color channels are required, one each for red, 

green and blue
• Gray level - One channel is required to specify the brightness
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• 8-bit pseudo color - Only one channel is required. Use imagery 
such as 8 bit TIFF, BMP and SPANS files

• Specify a directional light source
• Save terrain renderings to an image file on disk in a variety of   

supported formats. Once saved to disk, rendered scenes can be 
imported or printed by other software packages

• True vector overlay - (all GeoGateway® vector formats are        
supported)

Fly! Toolbar

Options
Change Position/Speed/Direction
• Modify the viewing position as well as the speed and movement 

direction with user entered values

Change Render Size
• Specify the size of the rendering window with user entered values 

or by interactively resizing display. The minimum is 64 by 64. The 
maximum is 1024 by 768

Change Perspective
• Modify the perspective parameters of the rendered image with 

user entered values for 'Height Magnification' elevation, 'Horizon 
Tilt' degrees, 'Pixel Zoom' foreground pixels at low elevations, and 
'View Cone' to exaggerate the effects of the perspective

Change 3-D
• Modify the parameters which control 3-D viewing with user entered 

values for 'Base Line' (specifies how far apart the left/right images 
are) and 'Focal Length' (specifies the focusing point in pixels)

Render mode
• Fogging - simulates a fogging effect in rendered scenes
• 2-D perspective color mode
• Anaglyph 3-D: Render frames which give an appearance of true   

3-D depth by generating slightly different left and right eye views. 
The user must wear anaglyph glasses (glasses with a blue lens for 
the left eye, red for right) when viewing the merged stereo image

• SGI workstations, allows for full color true 3-D depth flight that can 
be played back. The following rendering modes are available: 

• Stereoglasses: Puts FLY! into color stereo mode. Special 
hardware liquid crystal stereoglasses are required to view in 
this mode

• Stereoglasses (expanded): The stereo view is expanded in 
both the vertical and horizontal directions to produce an 
image 4x as large as the regular stereoglasses mode

Control Panel
• Set and report parameters relating to the viewer position, direction, 

elevation and speed

FLY! Control Panel

Coordinates
• Choose a reporting system for position: Options:
• Display: Position reported in pixels and lines in the loaded terrain
• Geocoded: Position reported in geocoded units as eastings and 

northings
• Geographic: Position reported in geographic units as longitude and 

latitude

Units
• Choose a reporting unit for distance and speed values. Options: 
• Metric: distance reported in m, speed in km per hour
• Imperial: distance reported in ft, speed in miles per hour

Speed Options
• Speed Maximum determines the range of speed values used. The 

minimum is always 0
• Scaling' determines the type of scale used to translate the range 

value to an actual speed

Rendering Window
Mouse buttons can be used to turn, pause/run, and change elevation 
quickly and naturally. The following button assignments are made:
• Left button - Turn. Changes the direction of viewing (and of     

movement). The new direction faces the position clicked on in the 
rendered image

• Middle button - Run/pause. User free flight is a special FLY! mode 
in which the viewer is continuously moving forward and toggles 
between pause (stop) and run (go)

• Right button - Change Elevation. Changes elevation proportional 
to the position of the mouse cursor in the vertical direction

FLY! Rendering Window
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Elevation Options
• Set the viewer elevation with the following options:

• Elevation Minimum' and 'Elevation Maximum' - determine the 
range of elevation values used

• Scaling' - determines the type of scale used to translate the 
range value to an actual elevation

• Mode' - dictates how the elevation value is actually translated 
into the viewer's elevation

• No collision' mode, - the rendering height is never allowed to 
occur below the land elevation

• Relative' mode, - the view elevation is the land elevation plus 
the value of the elevation scale

• Absolute' mode, the elevation scale value is used directly as 
the rendering height

Speed/Quality
Frames Per Second

• The distance, which the viewer advances, is based on the 
number of frames being generated per second and the    
specified flying speed

Rendering Quality
• Specify the quality of the images being rendered. Three options 

are available:
• Blocky rendering mode: each pixel appears as a box with pro-

nounced steps between pixels
• Fitted rendering mode: the edges of the pixels are             

interpolated so they fit together without any step effects.
• Smooth rendering mode: the edges of the pixels are         

interpolated so they fit together without any step effects and 
the colors of the pixels are smoothly blended

Flight Control Panel
• Create a flight path composed of several user-specified nodes. 

Nodes are selected on the nadir image
• Store the position, direction, and speed parameters as well as 

selected perspective parameters such as pitch, view cone, and 
zoom level for each node in a flight path

• The path is composed of a series of Bezier Splines made to fit 
through the nodes

• View the total length of the current flight path
• Edit nodes: Update changes the selected node to the current    

rendering parameters. Insert a new node. Add a node to the end of 
the current list. Delete a node. Clear all the nodes

• Play the flight back, with VCR-style controls (forward and reverse). 
Continuous playback mode can be used to cause the path to be 
flown repeatedly

 

Fly! Flight Control Panel

Movie Loop
Choose from several movie formats. It is possible to write out the 
movie as a series of individual images (i.e., frames). TIFF, TARGA, 
BMP, PPM and JPEG format files are available
Report the number of frames that should be generated for each     
second of playback time in the final movie loop product

Parallax Movie Loops
• Generate Movie Loops in the UNIX versions of FLY! that are     

written to the Parallax JPEG movie format (a Parallax video card is 
required)

Nadir View
• Show the overhead (or nadir) view of the terrain. This window is 

approximately 512 pixels by 512 lines in size and shows a         
decimated overview of the data if the loaded imagery is larger than 
this size. The window dimensions will vary to maintain a 1:1 aspect 
ratio

• Current position is shown in the nadir view as a black and white 
marker. The extension on the marker indicates the current     
movement direction

• Zoom imagery in nadir window

FLY! Nadir Window
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Mouse controls on the nadir view
• A left click in the nadir view will place the viewer at that location on 

the terrain
• A right click will change the move and viewing directions to point to 

that location
• A middle click changes the viewing direction only
• Toggle between views of the nadir terrain imagery or elevation

Nadir Options
• Show Path: the flight path is drawn in the nadir view
• Show Node Numbering: each node in the path is shown with its 

node number
• Path Color: flight path color can be changed
• Highlight Color: currently highlighted node color can be changed
• Path Resolution: Determines how many total line segments to use 

for drawing the splined path

Color Mixer
• Edit RGB colors in text fields with interactive selection menu

SPACEBALL (Only available on SGI platforms)
If a spaceball is attached to the workstation, it is possible to use it to 
maneuver through the image. Its usage is intuitive. Simply push the 
spaceball in the direction of movement: forwards, backward, left, right, 
up or down. Twisting the ball will also change the view/movement 
direction as well as the horizontal tilt

ALGORITHM LIBRARIAN

Geomatica's Algorithm Librarian provides easy access to hundreds of 
robust algorithms for image / vector processing and analysis. These 
tasks can be accessed either through the Focus viewer's Tools menu 
bar, or via the Modeler visual-scripting environment.

The Algorithm Librarian window lists the modules by category and 
subcategory. Selecting "All Algorithms" will list all the modules by their 
short form, alphabetically. By right clicking on the Algorithm heading, 
the Find search tool allows the user to perform intelligent keyword 
searches for individual tasks.

Algorithm Librarian Window

Below are comprehensive lists of the algorithm categories and       
specific tasks available in the Algorithm Librarian.

Geomatica
• PRIME 
• Advanced Optical (add-on)
• Advanced Radar (add-on)
• Advanced GIS (add-on)
• Advanced Hyperspectral (add-on)
• OrthoEngine Satellite Models (add-on)

Analysis
• AVHRR Analysis
• Change Detection
• DEM Analysis
• Favourability Analysis
• Geological/Geophysical Analysis
• Hydrogeologic Analysis
• Hyperspectral Analysis
• Multi-Layer Modeling
Classification
• Advanced Classification
• Data Exploration
• Neural Networks
• Post-Classification Analysis
• Supervised Classification
• Unsupervised Classification
 
Common Tasks
• Common
• Image
• Vector

Data Interchange
• CD Reading/Utilities
• Image Interchange
• Tape Reading
• Tape Writing/Utilities
• Text File Interchange
• Vector Interchange

Image Correction
• Atmospheric Correction
• AVHRR Orbital Navigation
• DEM Extraction/Generation
• Geometric Correction
• Orthorectification
• Image Mosaicking

Image Processing
• 3-D Rendering
• Data Fusion
• Enhancements
• Frequency Transforms
• Image Filtering
• Image Operations
• Image Transformations
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Radar Analysis
• Airborne Radar Analysis
• Polarimetric SAR Analysis
• SAR Speckle Filtering
• SAR Radar Analysis

Utilities
• Interpolation
• PCIDSK Reports
• PCIDSK Utilities
• Vector Utilities

Spatial Analysis
• Utilities - Edgematching and smoothing of vector layers
• Proximity Analysis - Merge (aggregate) a Thematic Raster based 

on attributes
• Topographer - DEM creation analysis and perspective scene    

generation 
• Conversion Tools - (Raster, Thematic Raster, Area and Arc)

ALGORITHM LIBRARIAN MODULE LIST

Package Module Description
Prime ADAPT Angle of Incidence From Elevation 
Satellite Models ADJDEM Adjust DEM Using Surface Fit
Prime ANG
Advanced Radar APC
Advanced Hyperspectral APPLRT
Prime ARC2AREA
Prime ARE
Prime AREAOFINF
Prime AREAPROB
Prime AREAREPORT
Prime AREAXTAB
Prime ARI
Prime ARICONST
Prime ARRREAD
Prime ARRWRIT
Prime ASP
Advanced Optical ATCOR1
Advanced Optical ATCOR2
Advanced Optical ATCORT1
Prime AUTOMER
Advanced Optical AVG
Advanced Optical AVHRCOR
Advanced Optical AVHRPANO
Advanced Optical AVHRRAD
Prime BBT
Prime BIT2LINE
Prime BIT2POLY
Prime BLO
Advanced Hyperspectral BRDFCOR
Advanced Radar CALSTOK
Prime CAR
Fundamentals CDASTER
Fundamentals CDEOSAT
Fundamentals CDIKONOS
Fundamentals CDIRSS
Fundamentals CDJERS1
Fundamentals CDLAND7
Fundamentals CDLANDB
Fundamentals CDLANDC
Fundamentals CDNLAPS
Fundamentals CDSAR
Fundamentals CDSAT

Package Module
Prime CDSH
Fundamentals CDSPOT
Fundamentals CDSPOT5
Fundamentals CDSPOTC
Advanced Radar CHDET
Prime CHNSEL
Prime CIB
Prime CMPRSS8
Fundamentals CNTGTHMR
Prime COMMENT
Prime CONTACTX
Advanced Optical CONTEXT
Prime CONTOUR
Advanced Radar CORNRD
Advanced Radar CORNREP
Prime CRCENTROID
Prime CRCHN16S
Prime CRCHN16U
Prime CRCHN32R
Prime CRCHN8U
Fundamentals CRNEAT
Fundamentals CRTHMR
Prime CSE
Prime CSG
Prime CSR
Prime DCWREAD
Prime DECORR
Prime DEMWRIT
Prime DENSITY
Fundamentals DIEST
Fundamentals DIGRP
Advanced Radar DIJPL
Prime DIP
Advanced Radar DITOP
Prime DLGREAD
Prime DLGWRIT
Prime DN2REF
Prime DRAIN
Advanced Hyperspectral DRSUB
Prime DSTRIPE
Prime DWCON
Prime EDGE
Prime EDMATCH
Airphoto Models ELGCPRMS
Airphoto Models ELVECRMS
Advanced Hyperspectral EMPLINE
Advanced Hyperspectral ENDMEMB
Prime ERRDIFF
Prime EXPORT
Prime FAV
Prime FCONT
Prime FED
Advanced Radar FEFROST
Advanced Radar FELEE
Prime FFREQ
Advanced Radar FFROST
Prime FGA
Advanced Radar FGAMMA
Advanced Radar FKUAN
Advanced Radar FLAP
Advanced Radar FLE
Advanced Radar FLIGHT
Prime FME
Prime FMO
Prime FPR
Prime FPRE
Prime FRD2P
Prime FSHARP
Prime FSOBEL
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Package Module
Advanced Radar FSPEC
Prime FSTDDEV
Prime FTF
Prime FTI
Advanced Hyperspectral FTLOC
Prime FUN
Prime FUSE
Prime FUSEPCT
Prime FUZCLUS
Prime FVDIF
Prime GCPELEV
Prime GCPFOOT
Prime GCPPRO
Prime GCPREAD
Prime GCPREP
Prime GCPWRIT
Prime GNG
Prime GRATGRID
Prime GRATIC
Prime GRDINT
Prime GRDPIN
Prime GRDPNT
Prime GRDPOL
Prime GRDVEC
Advanced Hyperspectral HDF2VQ
Advanced Radar HEADMOD
Advanced Radar HEADREP
Prime HIS
Prime HISDUMP
Prime HOM
Advanced Hyperspectral I2SP
Prime IDINT
Prime IHR
Prime IHS
Prime IMAGEADD
Prime IMAGECOS
Prime IMAGEDIV
Prime IMAGEINV
Prime IMAGELG2
Prime IMAGELN
Prime IMAGEMUL
Prime IMAGENEG
Prime IMAGERD
Prime IMAGESIN
Prime IMAGESQR
Prime IMAGESUB
Prime IMAGESUM
Prime IMAGEWR
Prime IML
Prime IMPORT
Prime IND
Prime IPG
Prime IPPI
Prime ISOCLUS
Prime KCLUS
Prime KNN
Prime KRIGING
Prime LINE
Fundamentals LINE2PNT
Fundamentals LINE2POLY
Fundamentals LINE2RAS
Fundamentals LINE2TLINE
Advanced Hyperspectral LINTRN
Prime LRP
Prime LUT
Prime LUTREAD
Prime LUTREP
Prime LUTWRIT
Prime MAGREP

Package Module
Prime MAGSTRU
Advanced Optical MAL
Prime MAP
Prime MARSHALL
Prime MAT
Prime MATCH
Fundamentals MEOSAT
Prime MERGE
Fundamentals METAIN
Fundamentals METAOUT
Prime MIAVHRR
Prime MIB
Prime MIDFAD
Prime MIDLG
Satellite Models MIEOSAT
Prime MIIFF
Advanced Radar MIJPL
Prime MIL
Prime MINDIS
Prime MIRROR
Fundamentals MIRSS
Fundamentals MJERS1
Fundamentals MLANDC
Prime MLC
Prime MLR
Advanced Hyperspectral MNFLT
Advanced Hyperspectral MNFNR
Prime MOSAIC
Prime MQSINT
Fundamentals MSAR
Prime MSH
Fundamentals MSPOT
Prime MTE
Fundamentals MTEXTRD
Fundamentals MTEXTWR
Prime MWW
Prime NDVI
Prime NGCLUS
Prime NGCLUS2
Advanced Optical NNCLASS
Advanced Optical NNCREAT
Prime NNINT
Advanced Optical NNREP
Advanced Optical NNTRAIN
Prime NUM
Prime NUMREAD
Prime NUMWRIT
Prime OLO
Satellite Models ORBITRD
Satellite Models ORBITWR
Prime OVERLND
Prime OVL
Prime PANFUSE
Advanced Pan Sharpening PANSHARP
Prime PCA
Prime PCE
Advanced Hyperspectral PCLT
Prime PCTFUS
Prime PCTINT
Prime PCTMAKE
Prime PCTREAD
Prime PCTREP
Prime PCTWRIT
Prime PCXREAD
Prime PCXWRIT
Prime POG
Prime POL
Prime POLY2BIT
Prime POLY2LINE
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Package Module
Prime POLY2PNT
Prime POTMAPSTAT
Prime POTMAPSUR
Prime PPTABLE
Advanced Hyperspectral PRINTLT
Prime PROCONV
Prime PROREP
Prime PROSET
Prime PRX
Prime PSGIMAG
Prime PSGMESH
Prime PWLUT
Prime PWLUT2
Prime PYRAMID
Advanced Radar QAREP
Prime RANDBIT
Fundamentals RAS2BIT
Fundamentals RAS2LINE
Fundamentals RAS2PNT
Fundamentals RAS2POLY
Prime RAS2THMR
Prime RCSTATS
Prime REC
Advanced Optical REDUCE
Prime REG
Prime REGUT
Prime REL
Prime RGB
Prime RGB2PCT
Prime RGBFUS
Advanced Hyperspectral ROLLCOR
Prime ROT
Prime ROTBIT
Advanced Radar RSTR
Prime RTR
Fundamentals RTV
Fundamentals RVRSBITS
Advanced Hyperspectral SAM
Advanced Radar SARBETA
Advanced Radar SARGEO
Advanced Radar SARINCD
Advanced Radar SARSIGM
Advanced Radar SARSIM1
Advanced Radar SARSIM2
Fundamentals SCALE
Advanced Radar SCATREP
Prime SCIWRIT
Prime SEED
Prime SEENARE
Fundamentals SETELEV
Advanced Hyperspectral SHFTCW
Advanced Radar SHRINK
Prime SIEVE
Prime SIGCLAS
Prime SIGMERG
Prime SIGSEP
Prime SLC2IMG
Prime SLP
Prime SMBOYLE
Prime SMCHAIKEN

Package Module
Prime SMMCMASTER
Advanced Hyperspectral SP2RT
Advanced Hyperspectral SP2SP
Advanced Hyperspectral SPCONVP
Prime SPLIT
Prime SPLREG
Advanced Hyperspectral SPUNMIX
Advanced Radar SRTOGR
Advanced Optical SST
Fundamentals STAMPJOIN
Advanced Radar STATJPL
Advanced Radar STDIJPL
Prime STE
Advanced Radar STGBIG
Advanced Radar STOKREP
Prime STR
Advanced Hyperspectral STRPCOR
Prime SUPCLAS
Prime SVFRD
Prime SVFWR
Advanced Radar SYNTH
Prime TASSEL
Advanced Radar TEX
Prime TEXREAD
Prime TEXREP
Prime TEXWRIT
Prime THMR2RAS
Prime THMRMER
Prime THMRORV
Prime THR
Prime THSNPOLY
Prime TIG
Prime TININT
Fundamentals TLINE2LINE
Advanced Radar TOPCLS
Fundamentals TPOLY2POLY
Prime TPSINT
Prime TRANSEC
Advanced Optical UNMIX
Prime USUPCLAS
Prime VBUFFER
Prime VDEMINT
Prime VECBUF
Prime VECCLEAN
Prime VECMERG
Prime VECREG
Prime VECREP
Prime VECSEL
Prime VECTHIN
Prime VIEWBW
Prime VIEWRGB
Fundamentals VIMAGE
Prime VLM
Prime VPROJ
Hyperspectral Compressor VQHSOC
Prime VREAD
Fundamentals VSAMPLE
Prime VWRITE
Prime WTRSHED
31/31

For more information contact:                                                   Distributed By:
  United States Tel: (703) 243-3700 Fax: (703) 243-3705
  Canada & International Tel: (905) 764-0614 Fax: (905) 764-9604
  Europe Tel: +44 1491 412 114 Fax: +44 1491 412 115
        Email: info@pcigeomatics.com        Web: www.pcigeomatics.com

Updated: 03 / 11 / 03
The information in this document is subject to change without notice and should not be construed as a commitment by PCI Geomatics.
PCI Geomatics assumes no responsibility for any errors that may appear in this document.
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